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Overview

This chapter covers the following topics:

¢ Performance Insight and the Ethernet Statistics Group
e RMON Ethernet Statistics

e Enhancements to version 3.20

e Integration with Network Node Manager (NNM)

e  Option for customizing reports

e  Sources for additional information

Performance Insight and the Ethernet Statistics Group

Performance Insight collects data from many sources, performs in-depth trend analysis,
maintains performance baselines, and provides users with convenient, web-based reporting.
Following is a partial list of product features:

e Distributed architecture

e Easy to scale (supports data collection from thousands of agents)
e CODA/PA agent support

e Multi-company security model

e Data warehousing

e Near Real Time reporting

e Forecasting

e Extensive aggregation (by day, week, month; by location, by customer)
e Thresholding and alerting

e Easy identification of bottlenecks

e Easy assessment of capacity trends

e Accurate and timely documentation for management

RFC2821 defines the statistics and functions that an RMON probe exchanges with a console
manager. The Ethernet Statistics Group is one of several data groups defined by RFC2821.
Data in the Ethernet Statistics Group is produced by the following counters:

e Drop events
e Octets
e Packets
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Broadcast packets

Multicast packets

CRC alignment errors

Undersized packets

Oversized packets

Fragments

Jabbers

Collisions

Packets containing fewer than 64 octets

Packets containing between 65 and 127 octets
Packets containing between 128 and 255 octets
Packets containing between 256 and 511 octets
Packets containing between 512 and 1023 octets
Packets containing between 1024 and 1518 octets

RMON Ethernet Statistics

The reports in RMON Ethernet Statistics will tell you what the counters listed above are
picking up. RMON Ethernet Statistics contains the following reports:

1
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Historical Broadcast/Multicast Packet Analysis

Near Real Time Broadcast/Multicast Packet Analysis
Historical Packet Size Distribution

Near Real Time Packet Size Distribution

Historical Error

Near Real Time Error

Drop Events

Inventory Report

Historical reports compare yesterday’s performance to performance over the previous month.
Near Real Time reports look at performance over the previous 12 hours. The counts and
percentages you see in a Near Real Time report factor in data retrieved by the most recent
poll, which took place within the last few minutes.

Enhancement to Version 3.20

Upgrade Package

UPGRADE_RMON_EthernetStatistics_to_32.ap

New Release of the Datapipe

RMON_EthernetStatistics Datapipe 3.31
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Integration with Network Node Manager (NNM)

If you use NNM as well as PI, you have the option of improving your ability to diagnose
problems by integrating PI with NNM. In the past, you integrated NNM and PI by installing
packages on both servers. This procedure recently changed. Package installation is no longer
necessary, as both NNM and PI ship with the necessary packages already installed. Instead of
installing packages, you run an integration script on the NNM server and you launch the
Integration Wizard on PI.

If NNM and PI are integrated, or if you are about to integrate them, be sure to install the
thresholds sub-package that comes with RMON Ethernet Statistics. Installing the thresholds
sub-package configures the Thresholds Module to monitor the PI database for broadcast/
multicast threshold breaches and respond to a breach by taking an action. The default action
is to send a breach trap to NNM. The breach trap received by NNM becomes an alarm in the
NNM alarm browser, which the NNM operator can respond to by launching an PI report.

Configuring the Thresholds Module is not necessary. You do not need to define an action or
specify a destination for breach traps. However, you are free to modify category, severity, and
destination parameters at any time. For details about these options, refer to the Thresholds
Module User Guide.

Options for Customizing Reports

Overview

You can customize the reports in this package by applying group filters, by editing parameters,
tables, and graphs, and by importing custom property data such as customers and locations.
Service providers, or any organization that wants to share reports with customers, use group
filters to produce customer-specific reports. Edits to parameters, tables, and graphs are
temporary changes and anyone can make these changes.

Group Filters

If you intend to share reports with customers, you will need customer-specific reports.
Creating customer-specific reports involves the following steps:

e Importing custom property information (customer names and device locations) using
Common Property Tables

¢ Creating a group account for all of the users affiliated with a particular customer
e Creating a group filter for the group account

For more information about group filters, refer to the PI Administration Guide.

Editing Parameters

When you edit a parameter, you apply a constraint. The constraint eliminates data you do not
want in the report. For example, if you edit the Customer Name parameter, data for every
customer except the customer you typed in the Customer Name field will disappear.

You can apply multiple constraints at once. RMON Ethernet Statistics supports the following
parameters:

e (Customer Name
e Device

e Interface

i



e  Protocol
e Location
If you are viewing the report remotely (using the Web Access Server), apply a constraint by

clicking the Edit Parameters icon at the bottom right-hand corner of the report. When the
Edit Parameters window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click Current Value. Type a new value and click OK.

Tables and Graphs

In addition to applying constraints, you can modify individual tables and graphs within a
report. To do this, click the Edit Table and Edit Graph icons, or simply right-click the object if
you are using the Report Viewer application. For details about view options for tables and
graphs, see Appendix A, Editing Tables and Graphs.

Custom Property Information

All the property information that pertains to an interface (interface speed, customer, location,
device name, and UtilThreshold) is inherited from the Interface Reporting Report Pack. If you
want to change the utilization threshold, you can let PI read a property import file that you
create yourself or you can work with the Change Protocol Defaults form that comes with
Interface Reporting. For details, see Chapter 3, Changing Thresholds.

Sources for Additional Information

The demo package that comes with RMON Ethernet Statistics contains a sample of each
report in the package. If you have access to the demo package and you want to know what
fully-populated reports look like, install the demo package. Demo reports are interactive;
selection tables are linked to graphs, and you can experiment with parameters and view
options.

For information about recent enhancements to this package and any known issues, refer to:
e  RMON Ethernet Statistics Report Pack Release Notes

The following documents are related to this manual:

e Interface Reporting Report Pack User Guide

e Common Property Tables User Guide

e PI Report Packs, CD-ROM Release Notes, September 2009

Manuals for the core product, PI, and manuals for the reporting solutions that run on PI, are
posted to the following web site:

http:/h20230.www2.hp.com/selfsolve/manuals

The user guides for PI are listed under Performance Insight. The user guides for report packs
and datapipes are listed under Performance Insight Report Packs. Every user guide indicates a
date. If a manual is revised and reposted, the date will change. Since we post revised manuals
on a regular basis, you should compare the date on your PDF to the date of the PDF on this
web site. If the web edition is newer, download the web edition.
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2 Package Installation

This chapter covers the following topics:
¢ Guidelines for a Smooth Install

e Upgrading to Version 3.20

e Installing RMON Ethernet Statistics
e Accessing Deployed Reports

e Package Removal

Guidelines for a Smooth Install

A PI reporting solution has two ingredients, a report pack and a datapipe. Some reporting
solutions include multiple datapipes. When you install a datapipe, you configure PI to collect
a specific type of performance data at a specific interval. When you install a report pack, you
configure PI to summarize and aggregate the data collected by the datapipe.

If you install the RMON Ethernet Statistics Datapipe, you will configure PI to poll the RMON
MIB. Installing the RMON Ethernet Statistics Report Pack configures PI to process data
collected by the datapipe, generate trending analysis, and display the results of that analysis
in a series of reports.

The report pack CD-ROM contains report packs, datapipes, and several shared packages.
When you insert the CD in the CD-ROM drive and launch the package extraction program,
the install script on the CD extracts every package to the Packages directory on your system.
When the extract finishes, the install script prompts you to launch PI and start Package
Manager. Before using Package Manager, review the following guidelines.

Software Prerequisites
RMON Ethernet Statistics Reporting has a combination of core-product requirements and
package-level requirements. The core product requirements are as follows:
¢ Performance Insight 5.41
e All available Service Packs for PI 5.41

You will find information about each service pack, including installation instructions, in the
release notes for the service pack. The package-level prerequisites are as follows:

e Common Property Tables 3.91

e Interface Reporting 5.52

e Interface Discovery Datapipe 2.50

e Interface Reporting ifEntry Datapipe 2.52

3



Common Property Tables

If you are running an earlier version of Common Property Tables, upgrade to version 3.91.
Installing the upgrade package for Common Property Tables is no different from installing
any other upgrade package; however, you cannot install other packages when you install this
upgrade package. Install the upgrade package for Common Property Tables and only the
upgrade package for Common Property Tables.

Running this Package in a Distributed Environment

If you intend to run RMON Ethernet Statistics as a distributed system across multiple
servers, the central server, every satellite server, and every remote poller must be running the
same version of PI and the same service packs. When you finish installing packages, you must
configure the central and satellite servers. For details, see Chapter 4, Setting Up a
Distributed System.

Upgrading to Version 3.20

If you are currently running an earlier version of RMON Ethernet Statistics, you can upgrade
to version 3.20 by installing the “to_32” upgrade package. Follow this sequence:

1 Uninstall the existing datapipe: RMON EthernetStatistics Datapipe 3.30
2 Install RMON_EthernetStatistics_Upgrade_to_32 (by itself, no other packages)
3 Install the new datapipe: RMON EthernetStatistics Datapipe 3.31

Before doing the upgrade, you may need to save configuration data related to polling policies
and polling groups. In addition, you may need to delete any views of data or property tables
that you created yourself. If you do not delete custom table views, the report pack upgrade
process may fail.

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information will be lost:
¢ The polling policy for a single remote poller

¢ (Cloned polling policies for multiple remote pollers

e (Customized polling groups

You can export existing polling policy configurations and customized polling groups by using
the collection_manager and group_manager commands.

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager
command to export existing policy configurations to a file.

UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Chapfer 2



Windows: As Administrator, launch a command window. Navigate to the PI install directory
and run the following command:

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations
If your environment contains customized polling groups, use the group_manager command to
export groups to individual .xml files.
UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME
./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the PI install
directory and run the following command:

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom views for data or property tables, the views you created may interfere
with the report pack upgrade, causing it to fail. Whether or not your custom views interfere
with the upgrade process depends on how you created them. If you created them using SQL,
the upgrade will succeed, however, your custom table views will not be available once the
upgrade is complete. If you created them using Datapipe Manager, the upgrade is likely to
fail. To prevent the upgrade from failing, delete custom table views before you upgrade the
report pack, then recreate these views after the upgrade is complete.

Installing RMON Ethernet Statistics

Follow these steps if you are installing RMON Ethernet Statistics for the first time:
e Task 1: Stop OVPI Timer and extract packages from the report pack CD
e Task 2: If necessary, upgrade Common Property Tables
e Task 3: Install the following packages:
— RMON_EthernetStatistics 3.20
— RMON_EthernetStatistics_Thresholds (optional)
— RMON_EthernetStatistics Datapipe 3.31
e Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD
1 Login to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.
On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.

Package Installation 5
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¢ From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens
automatically. On UNIX, the CD may or may not mount automatically; if it does not
mount automatically, navigate to the top level directory on the CD, and run the ./setup
command.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager install wizard opens.

When the copy to the Packages directory is complete, you can navigate to the Packages
directory to see the results. The Packages directory contains separate folders for RMON
Ethernet Statistics and the RMON_EthernetStatistics Datapipe. The following folders appear
under RMON Ethernet Statistics:

RMON_EthernetStatistics.ap
RMON_EthernetStatistics_Demo.ap
RMON_EthernetStatistics_Thresholds.ap
UPGRADE_EthernetStatitiscs_to_32.ap

The following folder appears under RMON_EthernetStatistics Datapipe:

RMON_EthernetStatistics Datapipe.ap

Task 2:Upgrade Common Property Tables

RMON Ethernet Statistics requires Common Property Tables 3.91. If you have not already
upgraded Common Property Tables, install the upgrade package. When you install the
upgrade, do not install other packages at the same time. Install the upgrade for Common
Property Tables and only the upgrade for Common Property Tables. If you need help with the
upgrade, refer to the Common Property Tables User Guide.

Task 3:Install RMON Ethernet Statistics and the datapipe

1

From the Management Console, select Tools > Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.

Click Install. Approve the default installation directory; or, if necessary, select a different
directory.

Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the PI Application Server.

Click Next. The Package Selection window opens.
Click the check box next to the following packages:
RMON_EthernetStatistics
RMON_EthernetStatistics_Thresholds (optional)
RMON_EthernetStatistics_Datapipe
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7  Click Next. The Type Discovery window opens; accept the default.
Click Next. The Selection Summary window opens.

9 Click Install. The Install Progress window opens. When installation finishes, an install
complete message appears.

10 Click Done to return to the Management Console.

Task 4:Restart OVPI Timer

On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.

On UNIX, as root, do one of the following:
— HP-UX: sh /sbin/init.d/ovpi_timer start
— Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed this report pack, you enabled the Deploy Reports option. As a result, the
reports in this package (as well as any forms) were deployed to the PI Application Server.
Once reports reside on the PI Application Server, you have two ways to view them:

e PI client applications
e Web browser

If the client applications are installed on your system, you have access to Report Viewer,
Report Builder, and the Management Console. If the client applications were not installed on
your system, you must use a web browser to view reports.

For details about the client applications, refer to the PI Installation Guide. For details about
the Management Console, including how to use the Object/Property Management view to
launch reports related to a specific object, refer to the PI Administration Guide.

Package Removall

Follow these steps to uninstall RMON Ethernet Statistics.

1 Login to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.

¢ From the Action menu, select Stop.

Package Installation 7
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On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

Start Package Manager. The Package Manager welcome window opens.

Click Next. The Package Location window opens.

Click Uninstall.

Click Next. The Package Selection window opens

Click the check box next to the following packages:
RMON _EthernetStatistics
RMON _EthernetStatistics_ Thresholds (if installed)
RMON _EthernetStatistics_Demo (if installed)
RMON_EthernetStatistics_Datapipe

Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens. When removal finishes, a removal complete
message appears.

Click Done.

Restart OVPI Timer.

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.

¢ From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— OSun: sh /etc/init.d/ovpi_timer start
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3 Changing Thresholds

When you installed RMON Ethernet Statistics and deployed reports, you also deployed one
form, the Change Threshold form. This form lets you perform a task related to an object. The
object is either a device and all of its interfaces, or an individual interface.

The Change Threshold form appears under Object Specific Tasks in the Object/Property
Management window. This form (along with other forms) will be listed under Object Specific
Tasks any time you select a device or an interface that is running the RMON probe.

The easy way to change the Broadcast/Multicast Threshold is to use the Change Threshold
form. The more difficult way to modify the threshold is to create a file that includes a new
threshold value, and then let PI import your file and update the property table.

Putting Property Data in a File

You can create an import file by building it from scratch, by exporting the required attributes
from your own provisioning database, or by letting PI collect some property data on its own
and then exporting what was collected. Since building a property import file from scratch is
not always easy, we recommend that you follow these steps:

1 Allow the system to discover a few devices on its own.
2 Export existing property data from PI by typing this command:
trend_proc -f RMON_EtherStats_exportdata.pro
Use the results as a starting point for a property file you will modify.

4 Store your modified file in the correct directory (where PI expects to find it) and import
the file by typing this command:

trend_proc -f RMON EtherStats_importdata.pro

If you do not type this command, PI will import your file at 4:00 a.m., well before daily,
monthly, and forecasting summaries are started. If the default source and destination
directories have not been modified, the import command will import data from, and the export
command will export data to, the following directory:

SDPIPE_HOME/data/PropertyData

9
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The following table describes the format of the Property Import file. If you are creating this
file yourself, make sure that your file adheres to this format. The sequence of attributes left to
right must follow this sequence of attributes top to bottom and your attributes must be
delimited by tabs, not spaces.

Attribute Type Default Description

Node name char_string,64 N/A Device name.
Interface name char_string,188 | N/A Interface name.
BcastMcastThreshold | integer 50 Broadcast/ Multicast

Threshold. The percentage of
traffic of type Broadcast or
Multicast.

If you export this file from PI, the format will be correct; no checking is necessary.

Using the Change Threshold Form

The value for Broadcast/Multicast Threshold is defaulted to 50%. Follow these steps to open
the Change Threshold form and modify the Broadcast/Multicast Threshold:

1 Open the Management Console.

2 Click the Objects icon.

3 Navigate to the interface you want to update and select it; or navigate to the device, if you
want to update the threshold for all of the interfaces on that device, and select it.

4 The Change Bcast-Mcast Threshold form is listed along with other change forms under

Object Specific Tasks.

5 Double-click the Change Bcast-Mcast Threshold form. The form opens.
Update the threshold as required.

7 Click Apply to save changes, then click OK to save changes and close the form. If you do not
want to save the changes you made, click Cancel.

Chapter 3
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h\ C:\0¥PI'\forms’deploy'adminRMON_EthernetStatistics

RMON Ethernet Statistics h
Change Threshold i(ﬁl

Use this form to change the default settings for Interface for the RMON Ethernent Statistics report
pack. You can modify the default Broadcast Multicast threshold settings for each Interface. Select
the Device, Interface you want to change the settings for, and then enter the new settings helow.
Click the Apply button to save any changes. Clickthe Cancel button to cancel any changes. Click
the OK hutton to save changes and close the form.

Device and Interface List
Device Name Interface Name Default BcastMcast Threshold

Broadcast Multicast Threshold

k|

K Apply | Cancel |

Conditions for Sending Traps fo NNM

The thresholds sub-package that comes with RMON Ethernet Statistics 3.20 will send a
threshold trap to your NNM server if the following two conditions are in effect at the same
time:

e The Broadcast/Multicast Threshold is being exceeded.
e The Utilization Threshold is being exceeded.

The utilization threshold is inherited from the Interface Reporting Report Pack. To modify
this threshold, use the Change Protocol Defaults form, shown below. For more information
about this and other forms bundled with Interface Reporting, refer to the Interface Reporting
Report Pack 5.52 User Guide.

Changing Thresholdss 2]
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Interface Reporting (ﬁB

Change Protocol Defaults

invent

Use this form to change the default settings for Protocols {nterface types) for the Interface Repaoring
report pack. You can change the names for Unknown protocols, and maodify the default duplex and
threshald settings for each protoocol. The systern can be configured to nat poll interface types that
hawe the Manitar flag set to O (0). Select the Protocol you want to change the settings for, and then
enter the new settings helow. Click the Apply button to save any changes. Click the Cancel button to
cancel any changes. Click the OK huttan to save changes and close the form.

Default Default Det

ifMype Protocol Hame Duplex Monitor  LHilization Discard Er
Threshold Threshold Thre
1 ather z 1 0000 1.00 il
z regulari 822 z 1 a0.00 .00 p;
e hdhigzz2 z 1 a0.00 200 b
4 ddn-:26 z 1 a0.0o 2.00 p:
b ol 7 72256 z 1 a0.00 .00 p
=] ethernet-cemacd 1 1 20.00 1.00 i
7 ise22023-csmacd 1 1 a0.0o 2.00 Z
a is0-8802d tokenBus 1 1 £0.00 .00 p
a iso-28025-tokenRing 1 1 50,00 .00 P
10 iso@2026-man 2 1 a0.0o 2.00 Z =
44 Harl oA bl 4 [niwNnlnl e Buln] -
Rl | r'
Protocol Name Iethern etramacd Monitor IMnnitur Ll
Litihization Threshold Error Threshold Discard Threshold
Thresholds |3n.nu |1.DD |1.DD
QK | Apply | Cancel |
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4 Setting Up a Distributed System

This chapter covers the following topics:
e Proper package installation

¢ Configuring a central server

e Configuring a satellite server

e System clocks

Proper Package Installation

If you intend to run the RMON Ethernet Statistics package as a distributed system, you must
configure all of the servers in the system. Before starting this task, use the following table to
verify that your servers are running the right packages.

Central Server Each Satellite Server

RMON_EthernetStatistics 3.20 RMON_EthernetStatistics 3.20

Common Property Tables 3.91 Common Property Tables 3.91

Interface Reporting 5.52 Interface Reporting 5.52

Interface Discovery Datapipe 2.50 Interface Discovery Datapipe 2.50

IR ifEntry Datapipe 2.52 IR ifEntry Datapipe 2.52
RMON EthernetStatistics Datapipe 3.31
RMON_EthernetStatistics_Thresholds
Thresholds Module 5.10

Typically, the central server does not poll. If you want the central server in your system to
poll, then you must install the RMON_EthernetStatistics Datapipe on the central server.

23



24

Configuring the Central Server

Task 1:

Task 2:

Task 3:

To configure the central server, perform the following tasks:

Task 1: Register the satellite server by setting the database role
Task 2: Enable LIR

Task 3: Add LIR mappings

Task 4: Verify the automatically generated copy policies

Task 5: Modify the trendtimer. sched file

Register the satellite server by setting the database role

1

o 0 A WN

Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the database system.
Click Database Properties.

From the Database Role list, select the Satellite Server role.

Enter any information necessary to configure the Satellite Server role.

To add a new database reference, you can use the Add Database Reference Wizard in the
System and Network Administration application.

Enable LIR

1

2
3
4
5

Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.
Click LIR Configuration.

Select the LIR enabled check box.

Add LIR mappings

1

O 00 N 00 0 A W N

[ —
= o

Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Click Add Mapping.

From the Select Satellite Server list, select a satellite server to which to add a mapping.
Select the Category data table option.

Select RMON Ethernet Statistics from the drop down list.

Select the rate data type.

Click Add to List.

If you want to add additional LIR mappings, click Add to list and repeat step 6 through
step 10.
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Task 4:

Task 5:

12 Click OK.
13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that
you add. The data type selected when adding an LIR mapping (in step 9 above) determines
the type of data copied that is defined in the generated copy policy (the type of data copied
that is defined in the generated copy policy is for one greater than the data type selected in
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is
generated.

Verify the automatically generated copy policies

Verify that a copy policy has been generated for the SHRMONEtherStats table and that the
copy type is set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the SHRMONEtherStats table and verify the copy type is set to Property and Data.
If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

w

Select a satellite server from the pull down list. This is the satellite server from which
data is copied to the central server.

Select Single Table and select SHRMONEtherStats from the pull down list.
Click Next. The Copy Type Selection Page displays.

Select Property and Data.

Click Next. The Summary page displays.

0 N O O A

Verify the information in the summary window. If the information is not correct, you can
modify it by clicking Back.

9  Click Finish.

If the copy type is not set to Property and Data, do the following:
1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Modify the trendtimer.sched file

The trendtimer. sched file is found in the {DPIPE HOME}/1ib/ directory where
{DPIPE HOME} is the directory in which PI is installed.

Make the following change to this file:
¢ Find and comment out the following line:

1:00+25 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/EtherStats Hourly Process.pro

Setting Up a Distribufed System 25
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Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE HOME}/libtrendtimer.sched file (where {DPIPE HOME} is the
directory in which PI is installed). Find and comment out the following line:

24:0045:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/EtherStats DMF Process.pro

2 Modify the EtherStats Hourly Process.pro file.

The EtherStats Hourly Process.pro fileis found in the {DPITPE HOME}/scripts/
directory where {DPIPE HOME} is the directory in which PI is installed.

Make the following change:
¢ Find and uncomment the following lines:
# begin: EtherStats 2 wait

# {DPIPE HOME}/bin/perl {DPIPE HOME}/scripts/IR Performance.pl -p
"Sat 1 EtherStats Copy" -t hour -v start

# {DPIPE HOME}/bin/trendcopy -t SHRMONEtherStats

# {DPIPE HOME}/bin/perl {DPIPE HOME}/scripts/IR Performance.pl -p
"Sat 1 EtherStats Copy" -t hour -v stop

# end: EtherStats 2

3 Configure polling policies for the RMON Ethernet Statistics Datapipe, making sure that
each interface is polled by only one satellite server.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock
on the central server. This step is extremely important. In distributed environments, linked
processes must run in exact sequences across independent machines.
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S5 Demo Reports

The chapter contains:
e A brief overview of the contents of each report (eight reports total)
e Screen captures

The screen captures come from the demo package.

1. Historical Broadcast + Multicast Packet Analysis

e Packet volume per interface for yesterday

e Ratio of broadcast traffic to multicast traffic for yesterday

e Multicast, broadcast, and unicast packets over two days (hourly)

e  Multicast, broadcast, and unicast packets over previous 31 days (daily)
e  Multicast and broadcast packet distribution for the previous 31 days

e Interface utilization over the previous 31 days

2. Near Real Time Broadcast + Multicast Packet Analysis [note: not illustrated]

e Packet volume per interface for the previous 12 hours

e The ratio of broadcast traffic to multicast traffic for the previous 12 hours

e Counts for multicast, broadcast, and unicast packets over the previous 12 hours

e Interface utilization over the previous 12 hours

3. Historical Packet Size Distribution

e Total number of packets for yesterday

¢ Percentage of packets with errors for yesterday

e QOctets for yesterday

e LAN segment utilization for yesterday

e Packet size distribution for previous two days (hourly)

e Packet size distribution for previous 31 days (daily)

e Percentage of broadcast and multicast packets for the previous 31 days

e Interface utilization for the previous 31 days

4. Near Real Time Packet Size Distribution

Total number of packets for the previous 12 hours

e Percentage of packets with errors for the previous 12 hours

Octets for the previous 12 hours

v



Utilization for the previous 12 hours

Packet size distribution for previous 12 hours

Percentage of broadcast and multicast packets for the previous 12 hours

Interface utilization for the previous 12 hours

. Historical Error Report

Packet volume per interface for yesterday

Percentage of packets with errors for yesterday

Percentage of packages with:

Fragment errors
CRCAlign errors
Undersize errors
Oversize errors

Jabber errors

Error count for the previous2 days (hourly)

Error count for the previous 31 days (daily)

Collisions for the previous 31 days

Probe drop events for the previous 31 days

. Near Real Time Error Report

Packet volume per interface for the previous 12 hours

Percentage of packets with errors for the previous 12 hours

Percentage of packages with:

Fragment errors
CRCAlign errors
Undersize errors
Oversize errors

Jabber errors

Error count for the previous 12 hours

Collisions for the previous 12 hours

Probe drop events for the previous 12 hours

7. Drop Events Report

28

Customer selection list

List of devices associated with the selected customer

Drop events per device for yesterday

Drop events per interface for yesterday
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Demo Reports

. Inventory Report
Customer selection list
List of devices associated with the selected customer

List of interfaces associated with the selected device
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RMON Ethernet Statistics

Historical Broadcast + Multicast Packet Analysis

[

invent

Thiz report has one entry for each interface, data in the selection table relates to all of yesterday combined. The tabbed areas graph

mowements over the previous hours and days. Excessive (* 10%) broadcast ar multicast packets can be detrimental to netwotk pedformance.
% Util zaleulates the utilization using the provisioned ifSpeed for half duplex interfaces.

Interface Data From Yesterday

Device Interface
Device_1293 4
Device 1265 a0
Device 1285 Fa
Device_ 1265 75
Cevice 1265 a4
Device 1265 ==}
Device 1265 1
Cevice 1265 T4
Device_1265 [=l=}
Device 1265 ag
Device_12G5 g3
Device_1265 a2
Device 1285 42
Device_12G5 43

Description

F astEthermetd
Module 7, Fart 12
Module 7, Fart 10
Module 7, Port 7
Module 2, Port 4
Module 7, Port 1
Module ¥, Fort 3
Module 7, Port G
Module &, Faort 20
Module &, Fort 12
Module G, Port ¥
Module &, Fort 6
Module 5, Fort 12
Module 5, Port 19

Make Model Customer
Foundny Netwo s Metlron Gigabit Switching Router Customer Unassigned

Howrly ‘ Craily ]
Packet Type Distribution for Previous 2 Days
For Device_1298: FastFthernetd4
100.20
B850 I rulticast %
Eeroadeast %
33.40 Cunicast %

Pkts %o LKl Beast %  Mcast %

5 N/ &0 20 il
207 215 u} TE bele]
207 214 u} Te 22
207,213 a T2 22
207,213 a T2 22
207 211 u} Te 22
207 211 a} 7E 2z
207,211 a T2 22
207,210 u} Ts 22
207 209 a} 7E 2z
207 208 a T2 22
207 207 u} Ts 22
207 206 a} s 22
207 206 a T2 22 j

AdminStatus Protocol Speed

Up is0ER023- cemacd Mot set.

ul
Wied 0000 Wed 02:00 ‘Wad 16:00  Thu 00:00 Thu O7:00 Thu 14:00 Tho 24:00 Fri 04:00  Fri 11:00

Broadcast + Multicast Packet Counts
For Previous 31 Days

5.40
U
E 3E0
=]
0
B O wulticast
o 120
E . Broadecast
Jul
Sat ton ifad
Mo 20 Dec 2 D 4
Tirne

% Utilization for Previous 31 Days

37.80

2820

1&.80
— Wil Threshald

% LHilization

w
B
[}

S=t ton Wied
Mo 20 D 2 Dec 4

Tirne
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Demo Reports

RMON Ethernet Statistics (ﬁP]
Historical Packet Size Distribution

invent

This report has one entry for each interface, data in the selection table relates to all of yvesterday combined. The tabbed areas graph
movements ower the previous hours and days. % Error Phis is the percentage of all padeets which were counted as having emros. % Uil
calculates the utilization using the prowvisioned ifSpead for half duplex intarfacas.

Interface Data From Yesterday

Device Interface Description Pkis % Error Pkt Octets % Ll
Dewice_1266 A1 ZigabitEthemet1/ 285,661 8348 0.00000 1206 =B 1 i‘
Dewiee_1268 129 F astEthermnet31 247,298 123 000000 1154 B 12
Dewice_1262 7T SummityiT=FPort 7 144,181 610 000000 99.2 B 1
Dewice_1288 25 REMOHN Part 25 on Unit 1 158,230,014 0.00000 a5.1 B 1
Dewiee_1290 246 EMON Port 25 on Unit 1 198,265,132 000000 a5.1 B 1
Dewice_1288 25 REMCON Port 25 on Unit 1 195,187 730 000000 93.1 3B 1
Dewice_1287 25 RMON Port 25 on Unit 4 155,179,748 0.00000 931 =B 1
Dewiee_1293 13 F astEthemet13 1,298,119,758 000000 246 B ]
Dewice_1282 11 EMON Part 11 on Unit 1 213,507 G666 0.00000 816 &B ]
Dewice_1283 11 REMOMN Part 11 on Unit 1 213,500,099 000000 8916 B =]
Dewvice_1282 2 REMCON Port 2 on Unit 1 515,516 670 000000 4.4 B =]
Dewice_1283 2 REMON Port 2 on Unit 1 515,517 548 0.00000 G644 &8 G
Dewiee_1300 113 EMONA000 Port 132 on Unit 1 G03,081 2632 000000 2.4 B =]
Dewice_1282 12 REMCOHN Part 18 on Unit 1 93,284,251 000000 853 3B =] j

Make Model Customer AdminStatus Protocol Speed

Foundny Mebuoks Raouter Customer Unassigned Up gigabitEtherneat 1.0 Gbis

Hourty | Daity |
Packet Size Distribution for Previous 2 Days
For Device_1266: GigabitEthernet1M
28,580,516 .00
Oru=5a
13,060,344 .00 B pidts 65-127

W Fids 128255

4,530,172.00 [ Phts 256-514
1T Wit 5121023
a ﬁ mﬁi O rus 10241515

Wed 00000 Wed 03:00 Wed 2100 Thu 02:00 Thoa 14:00 Tho 22:00 Fri 06:00

Broadcast + Multicast Packets U Litilization for Previous 31 Days
For Previous 31 Days
30,00
0.0 T
m 2280 1
1 5 |
: [
i £ 4500 1 e Ut
— - |
E M eroadeast % g T .
5 DI Multicast % 7504 — il Threshaold
ES i
0 0 ' '
Sat ton izd Sat [ laly] Wified
Mo 20 Dec 2 Dec 4 Mo 20 Dec 2 Dec 4
Time Tirne
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RMON Ethernet Statistics

Near Real Time Packet Size Distribution

(/3

invent

This repart has one entry for each interface, data is displayed for the most recent poll cycle and the graphs show the previous 12 hours.
% Erar Pt is the percentage of all packets which were counted as having emors. % Util calculates the otilization using the provisioned

ifSpeed for half duplex interfaces.

Device
Device_ 1262 10
Device_ 1282 10
Device_ 1283 10
Device_ 1294 10
Device_ 1242 10
Device_ 1288 10
Device_ 1287 10
Device_ 1289 10
Device_ 1290 10
Dewice_ 1293 10
Device_ 1236 10
Device_ 1295 10
Device_127G 10
Customer

Customer Unassigned

52016510

Facket Count

.10

% of All Packets

u]

AdminStatus

Up

Interface Data From Most Recent Poll Cycle
Change Constraints to Modify the List

Description
Summit? iTx-Port 10
RO Port 10 on Unit 1
RO Port 10 on Unit 1
10
izigabitEthernet1d
RMOMN Port 10 on Unit 1
RhiOMN Port 10 on Unit 1
RMOMN Port 10 on Unit 1
RhiOMN Port 10 on Unit 1
FastEthermet10
BZ
FastEthermet1d
SummitdSi-Fart 10

Protocol

ethernet csmacd

Pkis

203,619
384,820
284,635
267 653
0,025
4,287
4,286
4,284
4,270
4,224
1,620
s07

212

Speed

100.0 Mb/fs

Packet Size Distribution For Previous 12 Hours
For Device_1262: SummitfiTx-Port 10

% Error Pkt Octets %o LHil
0.00000 1953 MB 2 -
0.00000 2855 ME 3
0.00000 2834 MB 3
0.00000 1493 MB 1
0.00000 8735 KB o
0.00000 504.7 KB o
0.00000 504.5 KB o
0.00000 504.5 KB o
0.00000 504.0 KB o
160985 £15.3 KB o
0.00000 140.2 KB o
0.00000 &1.0 KB o
0.00000 18.4 KB o j

Duration
Poll Cycle Start (sec)
Fri DecOB 13:15:00 EST 2002 806
II I O Pt 5

EPits 65-127

B Fits 1258-255
II II CIPits 256-511

W Fid= 5121023

01:00 Ak 0220 AN 0445 AM OS5 A 0720 Ak 09:00 Ak

Time

Broadcast + Multicast
For Previous 12 Hours

DElroadcast %
Otutticast %

Fri

01:00 Ak 05:30 Ak 10:00 Akd
Time

32

Fri

%h Lkilization

10:45 Al 1215 P

Y Ltilization

OFits 10241515

For Previous 12 Hours

23.60
23.70
19.80
39.80
a T
Fri Fri Fri

04:00 Ak 0500 AM 14:00 Ak

Tirme

— % Util
— il Threshald
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RMON Ethernet Statistics [}
Historical Error Report (ﬂ

invent

This report allows you to select interfaces based on their pedformance yesterday. The graphs below the selection table show data for the
previous hours and days for the selected interface. % Error Phis is the percentage of all packets which were counted az having erors. Of the
errar padets, % Frag is the ratio which were fragmented - the zame applies to % CRC Align, % Under, % Ower and % Jabbers. Drop events
signify when the RMOM agentiwwas unable to maintain the counters and had to ignore sets of packets,

Interface Data From Yesterday

Device Interface Pkts % Error Pkt % Frag % CRCAlign % Under % Quer % Jabbers
Dewice 1263 8 1 10000000 a 100 a a a -
Device_1292 10 20,575,326 1205126 100 u] u] u] u]

Dewice_ 1242 102 32,595,144 2027441 100 u} u} u} u}
Cewice_1301 1003 105,283 TATETS A 54 a a a
Drewice_1294 10032 105,285 T ATEES Gl S u} u} u}
Dewice_1294 1006 258,201 FANTTA 295 5 a a a
Cewice_1301 1005 268,219 TA1T721 a5 5 a a a
Dewice_ 1265 21 286,784 592537 u} 100 u} u} u}
Dewice_1247 1014 1,456,458 386616 100 a a a a
Dewice_1245 1014 1,466,459 226616 100 u] u] u] u]
Dewice_ 1293 2 G442 G5 266283 100 u} u} u} u}
Dewice_ 1293 =} 828,206 251337 =R =1 a a a
Dewvice_1262 200 225,932 1.65220 et] 1 u] u] u]
Dewice 1292 12 254523 1.55572 r j=ic} u} u} u} j
Make Model Customer AdminStatus Protocol Speed
Foundry Netmars Router Customer Unassigned Up gigabitEthernet Mot zet.
Hourly l Diaily ]

Error Counts for Previous 2 Days
For Device_1263: GigabitEthernet1:8

1.00
ﬁ .Undersize
E 0.50 Chrersize
r DJabbers
= DFragmeniS
0 -4 ¥ f t f f t t Ockre Align Errors
Wed 00:00 Wed 05:00 Wed 16:00 Tho 00:00 Tho 02:00 Thuo 16:00  Fri 00:00 Fri 0700
Time
Packet Collision Counts for Previous 31 Days Probe Drop Events for Previous 31 Days
001 T 0.01 7
t £
3 =]
8 o
c 1 I )
o >
I} i
= o
3 o
=]
a + + t + t + a t + + + + t
Sat Sun Man Tue ied Thu Sat Sun han Tue e d Thu
Mow 30 Dec1 Dec?2 Dec3 Decd Dech Mov 30 Dect1 Dec? Dec3 Decd Decd
[rate D ate
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RMON Ethernet Statistics
Near Real Time Error Report

[

invent

This report has one entry for each interfface, data is displayed for the most recent poll oyele and the graphs show the previous 12 hours.

% Error Phits is the percentage of all padiets which were counted as having errors. Of the error padkets, % Frag is the ratio which were
fragmented - the same appliesto % CRC Align, % Under, % Owver and % Jabbears.

Device Interface
Crewice_ 1293 10
Drevice_1251 10
Crewice_1252 10
Crevice 1249 10
Crevice_1244 10
Crewice_ 1287 10
Device 1283 10
Crewice_1289 10
Crewice_1290 10
Devica_128G6 10
Crevice_1284 10
Crewvice_ 1282 10
Drewice_1283 10

Customer

Customer Unassigned

232.20

Facket Count

154.20

7740

u]
Fri

Fri

Interface Data From Most Recent Pall Cycle

Pki=s
4224
a
a
a
267 G653
4,285
4,287
4284
4,279
1,629
3
84,220
384,635

AdminStatus

Up

Fri

Fri

% Error Pkt

1.60025
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000

Protocol

Error Packets
Total Packet Counts for Previous 12 Hours

Fri

" Frag

100

o o o o o o o o oo o0

038023 cemacd

Fri

% CRCAlign

u]

[ T T Y o R S o I |

Speed

0.0 Mbls

Fri

Change Constraints to Modify the List

% Under " Ower "a Jabbers
0 0 0 =
a a a
a a a
a a a
a a a
u] u] u]
a a a F—
a a a
u] u] u]
a a a
a a a
u] u] u]
a a a j
Duration
Poll Cycle Start (sec)

Fri Dec 06 13:15:00 EST 2002

Fri

Fri

O1:00 Ak 0Z2:20 A0 0400 AM 0520 AWM O7:00 AM 02:20 AM 10:00 AM 11:20 AM 07100 PM

30320

227.40

151,60

FPacket Count

7520

u]

PacKet Collision Counts
For Previous 12 Hours

Time

Fri

Fri

Fri

O1:00 AR 0400 AN 0700 AM 10:00 Ak 0400 PM

Tirne

Drop Ewent Court

ool 7

ok

M undersize

H owversize
DJabhers

DFragments

[CJcre align Erors

Prohe Drop Events
For Previous 12 Hours

205

Fri

Fri

Fri

Fri

Fri

000 AM 0245 AN 0845 AM 0220 AM 12:20 PM

Tirne

Chapter 5



Demo Reports

RMON Ethernet Statistics ()
Drop Events Report (B

invent

This report has one entry for each customer and provides information on aggregated Drop Events for each RMOMN Ethermnet Statistics enabled
device, A'DropEvent is defined as"The total number of events in which packets were dropped by the probe due to lack of resources, Mote
that this number is not neces=zarily the number of padiets dropped; it is just the number of times this condition has been detected.”

tadify the report constraints to limit the number of interfaces displayed. Only devices palled yesterday will be displayed.

Customer Customer Id

Customer Unassigned -2

Devices Associated the Selected Customer

With DropEvents Yesterday
Device Make Model Drop Events
Device_1284 Intel Corporation 50T Standalone Switch (24 port). 45

Interfaces Associated with 64.42.232.1: Intel Express 460T Standalone Switch (24 port).
Change Constraints to Modify the List

Interface etherStatsindex AdminStatus Protocol Full:Half Speed Drop Events

1 1 Up ethermet-csmacd H 100.0 hMbiz 45
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RMON Ethernet Statistics
Inventory Report

O

invent

Thiz report has one entry for each customer and provides inventory infarmation for the provisioned intefaces supporting RMON Ethernet

Statistics data. Modify the report constraints to limitthe number of interfaces displayed. Only interfaces which weere polled yesterday will be

dizplayed.

Device
Crewice_ 1160
Device_ 1161
Crewice_ 1162
Crewice_ 1163
Device_1242
Crewice_ 1243
Crevice 1244
Device_1245
Crewice 124G
Crevice 1247
Device_1248
Crewice_ 1249
Device_1250
Device_1251
Crewice 12562
Device_1255

Interface
4

1

Customer
Customer Unassigned

Customer Id

-2

Devices Associated with the Chosen Customer

Model

Make
rellfleet M
Hylan Carp. Aleatel OmniSwitch
Extreme Nebwots Summitdsi
Extreme Nebwots Summitda

Foundry Metwofs
2Com

Hewlett Packard
Intel Corporation
Extreme Nebwots
Extreme Nebwots
rellfleet
Extreme Nebwots
Extreme Nebwots
Extreme Netmwodes
Extreme Nebwots

Cizco

Senerlron Switch

SuperStack Il

JA313A ProCunce Switch 2524

S50T Express S50T Switch
Alpine3z0z
Alpine3303

NA,

Summitde
Summitds
Summitdd
Summitde
TZ06WXR

sysDescr
Image: relM32.10/ Created on M... -
Adcatel OmniSwitch
Summitddi - Version 5.2.2 (Bui...
Summitdd - Wersion 4.1 19 (Bui...
Foundry Metrwoms, Inc. Senmerl...
2FCom Superstack |
HF J4313A ProCurve Switch 2524
{c) Intel Corporation, 5507 Ex...
Alpine3808 - Version §.2.2 (Bu...
Alpine3808 - Version §.2.2 (Bu...
Image: rev 130005 Created o...
Summitdd - Wersion 4.1.19 (Bui...
Summitds - Wersion 4.1.19 (Bui...
Summitds - Wersion 4.1.19 (Bui...
Summitdd - Wersion 4.1.19 (Bui...
Cizzo Internebwok Operating 5. j

Interfaces Associated with the Chosen Device
65.113.244.1: Image: rel/13.10/ Created on Mon Hov 23 19:10:42 EST 1998,

etherStatsindex

AdminStatus

Protocol

Up other

FullHalf
F

Speed Location
In: 100.0 hbfs Out: 1000 Mbéz Location Unassigned
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A Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, right-click the object
to open a list of view options. If you are using the Web Access Server, follow these steps to
change the default view of a table or graph:

1  Click Preferences on the links bar.

Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click the Edit icon next to the table or graph.

o O AW N

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options

Sek Time Period,, .
Change Constraint Yalues. ..
Seleck Modes/Interfaces. ..

Change Max Rows. ..
Wiew in new Frame

Print Table. ..

Export Element as C3Y...
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ge8 Table Yiewer 1]

Polled IP QoS Statistics Data - Input
Crver Previous 6 Hours

Oirection IpPrecedence Switched Bytes Switched Phts Tirme Period
Input a 105,688 §78 Tue Oct 28 07 :00 Abd
Input 1 u} u} Tue Oct 29 0700 Al
Input 2 u} u} Tue Oet 29 0700 Al
Input I} u} u} Tue Dot 29 0700 Abd
Input 4 a a Tue Dot 20 0700 Abd
Input 5 u} u} Tue Oct 29 0700 Al
Input G Goo 5 Tue Oct 29 07:00 Al
Input 7 u} u} Tue Dot 29 0700 Abd
Input a a2 334 5328 Tue Oct 28 06:45 Abd
Input 1 u} u} Tue Oct 29 0695 Al
Input 2 u} u} Tue Oct 29 0545 Al
Input I} u} u} Tue Dot 29 06:45 A
Input 4 a a Tue Oct 20 0645 Ahd
Input 5 u} u} Tue Oct 29 0695 Al
Input =1 u} u} Tue Oct 29 0545 Al
Input 7 u} u} Tue Dot 29 06:495 A
Input a a7 5348 G432 Tue Oct 28 06:30 Ahd
Input 1 u} u} Tue Oct 29 0630 Al
Input 2 u} u} Tue Dct 28 0G:30 Ak
Input 3 a a Tue Dot 20 06:30 A
Input 4 a a Tue Oct 29 06:30 Al

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

Add Gwerlay, ..

Remove Overlay.

409.00 1 Set Time Period. ..
Change Constraint Yalues. ..

22T .20 Select Modes/Inketfaces. ..

Displaved Data

245.40 | arid
Legend

v v v | W

162.60 1 . Stvle

Change Max Rows, .,
51.80 1 Display Data Table
Export Element as C5Y...

Display Cwerlay Data Table

Sep 17 Sep 21 Sep 25 Sep 29 Export Graph Overlay Data as G5y,

View in new Frame
Print Graph. ..
Delete Graph
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The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines
Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

fdd Cwerlats .,

Remaye Cver|ay PM

Sek Time Period. ..

Change Constraint VYalues. ..

Select Nodes)Interfaces. ..

Displayed Data 3 % !

Grid ]

Legend b /\

Skwle Area

Change Max Rows. . Stacking Area

Display Data Table Bar

Expart Element as CSY... Stacking Bar

Display Sverlay Data Table P

Export Graph Overlay Data as C54, . » Plok

Vet in new Frame Scatter Plot

Prink Graph... e a

e Hi-Lo-Cpen-Close -
e Cande

I AaLa

Edliting Tables and Graphs



40

Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

Disconnect Cause Hourly Totals for Yesterday
For Selected Gateway Group

142.40
1123.50

95,60

71.70 A.

Sat Feb 24 06:00 AM EST
Mormal Dizconnect (107 is 7400

2290 %

a + A + } + + + +
0400 ag:ao0 0500 10:00 12:00 14:00 1600 15800 20:00 22:00

‘alume

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

l% 200.00

160,00
120000
&0.00

40.00

Maon 01 Tue 02 Wed 032

M 2vg Utilization ¢HY
Bt Utilization (H)
M Util Threshold
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

11,324.00
9,539.20
7,154.40

4,763 B0

Forecast Minutes

2,384 20

i} I S |
Thu 01 Fri 02 Szt 0z Sun 04 bMon 05 Tue 05 Wed O7

Day=s Of The Week

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.
200,00
160,00
120,00
S0.00

40.00

u]
ton 01 Tue 02 Wed 032

B ~ovg Utilization ¢H)
[ b2 Utilization (H)
M Uil Threshold

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.
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T840

g2.80 P\
4710 [T M K| %
31.40

15.70

teon 01 Tue 02 Wied 02

— Auwrg Utilization (H)
— hdax Utilization (H)
— Wil Threshaold

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

Minutes Of Use Distribtions for Yesterday
For Selected Customer

W Under 1 minute

E petween 1 and § minutes

O petween § and 20 minutes

O petween 20 minutez and 2 hours
B petween 2 hours and 12 hours
M 0ver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.
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Display Data Table

This option changes a graph into a spreadsheet.

~lolx

¥ Axis I Average |

Tue Feb 19 ... 0,309
Tue Feb 19 ... 0.621
Tue Feb 19 ... 1.026
Tue Feb 19 ... 0,362
Tue Feb 19 ... 1.171
Tue Feb 19 ... 1.051
Tue Feb 19 ... 0,254
Tue Feb 19 ... 0,326
Tue Feb 19 ... 1.4583 %
Tue Feb 19 ... 0,967
Tue Feb 19 ... 1.471
Tue Feb 19 ... 1,308
Tue Feb 19 ... 1.123
Tue Feb 19 ... 0.93
Tue Feb 19 ... 1.497
Tue Feb 19 ... 0,306
Tue Feb 19 ... 0.725
Tue Feb 19 ... 0,875
TueFeb 19 ... 1.06
Tue Feb 19 ... 1.254
T oL A Lt Rl

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

=18l

Hetwork Response Time
Cisco_D4
Tue Feb 19 12:00 Ah - Tue Feb 19 11:00 P

Seconds

Tus 0500 A Tug 11:00 FM
— Fwerage
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Glossary

broadcast packet

A packet that is transmitted to all hosts on an Ethernet. The reports in the RMON Ethernet
Statistics package show the ratio of broadcast packets to other types of packets.

collision

A collision is the result of two devices on the same Ethernet network attempting to transmit
data at exactly the same time.

drop event

An overrun at a port. The RMON port could not receive and process the traffic at full line rate
and had to drop some packets from the counters. Changes in drop events can be caused by an
overburdened RMON infrastructure.

fragment

A piece of a packet. Sometimes a communications packet being sent over a network has to be
temporarily broken into fragments; the packet is reassembled at the destination.

jabbers

Packets that were longer than 1518 octets and also contained alignment errors.

multicast packet

Communication between a single sender and multiple receivers on a network. The reports in
the RMON Ethernet Statistics package show the ratio of multicast packets to other types of
packets.

packet

A unit of data formatted for transmission on a network. Data is broken up into packets for
sending over a packet switching network. Packet counts are shown with discard ratios.

port

Any frame relay interface on any network device that supports MIB-II.

octet

Eight bits. The term “octet” is sometimes used instead of the term “byte” to avoid confusion,
because not all computer systems use bytes that are eight bits long. The reports in the RMON
Ethernet Statistics package show octet counts on the LAN segment.

oversize packets

The number of packets received that were longer than 1518 octets but otherwise well formed.
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Index

B
broadcast/multicast threshold, 20
Broadcast Packet, 45

C

change max rows option, 39

Change Protocol Defaults form, 21

Change Threshold form, 19
collection_manager, 14

Common Property Tables upgrade package, 14
customer-specific reports, 11

custom views of data or property tables, 15

D

Datapipe Manager, 15
demo package, 12
Display Data Table, 39
displayed data option, 39
Drop Events, 45

Drop Events Report, 28

E

editing parameters, 11

exporting property data from PI, 19

G
grid options, 39
group_manager, 14

group filters, 11

H

Historical Broadcast + Multicast Packet Analysis, 27

Historical Error Report, 28
Historical Packet Size Distribution, 27

|
importing property data, 19
Inventory Report, 29

L
legend options, 39

M
Multicast Packet, 45

N

Near Real Time Broadcast + Multicast Packet
Analysis, 27

Near Real Time Error Report, 28
Near Real Time Packet Size Distribution, 27

P

polling policies, 14, 26
property import file, 19

R
RMON_EtherStats_exportdata.pro, 19
RMON_EtherStats_importdata.pro, 19

S

style options for graphs, 39
system clocks, 26

U
Use Absolute Time, 37

\'

view in new frame, 38
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We appreciate your feedback!

If an email client is configured on this system, by default an email window opens when you
click on the bookmark “Comments”.

In case you do not have the email client configured, copy the information below to a web mail
client, and send this email to docfeedback@hp.com

Product name:
Document title:
Version number:
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